Notices: The information in this document is subject to change without notice. NO WARRANTY OF ANY KIND IS MADE WITH REGARD TO THIS MATERIAL, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. No liability is assumed for errors contained herein or for incidental or consequential damages in connection with the furnishing, performance, or use of this material. This document contains proprietary information that is protected by copyright. All rights are reserved. No part of this document may be photocopied, reproduced, or translated into another language without prior written consent.

Trademark Acknowledgments: Windows is a registered trademark of Microsoft Corporation. All other trademarks are the property of their respective owners.

Printing History
Edition 5.0, #111912, Copyright 2010, All rights reserved.

FCC Compliance Statement: This device complies with part 15 of the FCC rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

For Users in the United States: This product is intended to be supplied by a UL listed Direct Plug-In Power Supply marked “Class 2” or a UL listed ITE Power Supply marked “LPS” with output rated 12VDC, 4.5A or higher. This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. In a domestic environment this product may cause radio interference, in which case the user may be required to take adequate measures. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Re-orient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

Use of shielded cables is required to comply with the Class A limits of Part 15 of the FCC Rules. You are cautioned that any changes or modifications not expressly approved in this manual could void your authority to operate and/or obtain warranty service for this equipment.

For Users in Canada: This digital apparatus does not exceed the Class A limits for radio noise for digital apparatus set out on the Radio Interference Regulations of the Canadian Department of Communications. Le present appareil numerique n’émet pas de bruits radioelectriques depassant les limites applicables aux appareils numeriques de la class A prescrites dans le Reglement sur le brouillage radioelectrique edicte par le ministere des Communications du Canada.

CAUTION!
TO PREVENT FIRE OR SHOCK HAZARD, DO NOT EXPOSE THE UNIT TO RAIN OR MOISTURE. TO REDUCE THE RISK OF ELECTRIC SHOCK, DO NOT REMOVE EXTERIOR PANELS. NO USER-SERVICEABLE PARTS INSIDE. REFER SERVICING TO QUALIFIED SERVICE PERSONNEL. OPERATE THE UNIT WITH ONLY THE PROPER ELECTRICAL SPECIFICATIONS AS LABELED ON THE PRINTER AND AC ADAPTER.

CAUTION!
THIS PRODUCT CONTAINS A LASER DIODE OF A HIGHER CLASS THAN 1. TO ENSURE CONTINUED SAFETY, DO NOT REMOVE ANY COVERS OR ATTEMPT TO GAIN ACCESS TO THE INSIDE OF THIS PRODUCT. REFER ALL SERVICING TO QUALIFIED PERSONNEL. THE FOLLOWING LABEL APPEARS INSIDE YOUR UNIT:
CLASS 1 LASER PRODUCT LASER KLASSE 1

CAUTION!
USE OF CONTROLS OR ADJUSTMENTS OR PERFORMANCE OF PROCEDURES OTHER THAN THOSE SPECIFIED HEREIN MAY RESULT IN HAZARDOUS RADIATION.
# Table of Contents

**Section 1: Getting Started**

A. Note on Model Differences .................................................1
B. Choosing a Good Location ..................................................2
C. Unpacking and Inspection ....................................................3
D. Identifying the Parts ............................................................4
E. System Requirements ..........................................................6
F. Loading Media .................................................................6
G. Installing Ink Cartridges .....................................................8
H. Setup the Kiosk Bin ............................................................10

**Section 2: Creating Discs**

A. Tutorial: Copy a Disc (PRINT ONLY FOR AUTOPRINTER USERS)......12
B. Using PTPublisher .............................................................15
   B1. Project Types ...............................................................15
   B2. Steps to Any Project .....................................................17
      Step 1. Add Data .............................................................17
      Step 2. Add Print .............................................................18
      Step 3. Start Project (Summary - Settings) .........................19
   B3. Robot Options .............................................................22
   B4. Publisher Status ..........................................................23
   B5. Backup Project (PC Disc Publisher Only) .........................24
   B6. Rip Audio (PC Disc Publisher Only) ................................27
   B7. PTProtect (PC Disc Publisher Only) ...............................28
   B8. Project Sets (PC Disc Publisher Only) ............................29
C. Creating a Print Label Using SureThing (PC) .........................31
D. Creating a Print Label Using Disc Cover (Mac) .......................32
E. Advanced Printer Settings ..................................................36
F. Using Other Graphics Programs ..........................................42

**Section 3: Maintenance and Troubleshooting**

A. Interpreting the Publisher’s Indicator Lights ..........................43
B. Internal Blue LED Lights ....................................................44
C. Transporting the Publisher ..................................................44
D. Cleaning the Print Head .....................................................45
E. Replacing the Print Head ....................................................47
F. Technical Support ..............................................................49

**Section 4: Technical Specifications** .............................................50

**Index** ..................................................................................51
Interactive Feature in this PDF Document

There are interactive features that will allow you to jump to different locations within the document. Each listing in the Table of Contents is interactive. Place the cursor on either the words or the page number. A small hand with a pointing finger icon appears. Click on the line with the icon and the document will jump to that page. If you want to return to the Table of Contents, move the icon to the top of the page and click on the arrow marked TOC.

Navigating through the Index is similar. Place the icon on one of the listings or page numbers, click on it, and it will move to that page. The text relating to the Index listing will appear in red. Returning to the Index can be done by clicking on the arrow marked Index.
Section 1: Getting Started

THANK YOU...

...for purchasing a Bravo 4100 Series Disc Publisher. Bravo is the perfect all-in-one solution for producing professional looking discs. A wide variety of disc formats are supported, including audio CDs, DVD Video, data discs and more. Operation is simple and completely automatic once a project has been started.

To begin using your Disc Publisher, please read this manual carefully. This Operator's Manual is a complete step-by-step guide to quickly and easily create discs with your new Optical Disc Publisher.

A separate Help file is provided with your Publisher that explains the operation of the PTPublisher Software. Click the icon in the software to access the help file.

NOTE ON TERMS AND CONVENTIONS:

From this point forward, the following terms and conventions will apply:

The Bravo 4101, Bravo 4102 and Bravo 4051 Disc Publisher will be abbreviated simply as the Publisher. The Bravo 4100 AutoPrinter will be refered to as the AutoPrinter.

Optical discs, which can include many different types of discs including CD-Rs, CD-RWs, DVD+/−Rs, BDRs and more are all referred to as CDs or discs. Please note that in order to copy and record BDRs, you will need to have purchased the Blu-ray version of the Publisher.
A. NOTE ON MODEL DIFFERENCES

The Bravo 4100-Series comes in seven different models including:

- Bravo 4051 (1 DVD Drive) Burns and Prints CD, DVDs and DVD-DL, 50 disc capacity, No Kiosk.
- Bravo 4051 BLU (1 BDR Drive) Burns and Prints CD, DVD, DVD-DL, BDR and BDR-DL, 50 disc capacity, No Kiosk.
- Bravo 4100 AutoPrinter (No Drives) Print Only, 100 Disc Capacity with Kiosk - See Section 3A, C and D.
- Bravo 4101 (1 DVD Drive) Burns and Prints CD, DVDs and DVD-DL, 100 Disc Capacity with Kiosk.
- Bravo 4102 (2 DVD Drives) Burns and Prints CD, DVDs and DVD-DL, 100 Disc Capacity with Kiosk.
- Bravo 4101 Blu (1 BDR Drive) Burns and Prints CD, DVD, DVD-DL, BDR and BDR-DL, 100 Disc Capacity with Kiosk.
- Bravo 4102 Blu (2 BDR Drives) Burns and Prints CD, DVD, DVD-DL, BDR and BDR-DL, 100 Disc Capacity with Kiosk.

These instructions are written to apply to all models. For example there are no special instructions for burning Blu-ray Discs™ if you have a Blu-ray model. The software simply recognizes that you have Blu-ray capable drives and adds the BDR media type to the list of available media to burn.

**Important Note:** The Bravo 4101 Blu or Bravo 4102 Blu requires the Disc Publisher to be connected to the computer USB for printing AND eSATA cable(s) for the drives. Both eSATA and USB are required! The eSATA PCI express card included with the unit may need to be installed if you do not already have eSATA ports on your computer. Refer to the instructions included with the card for more details.

B. CHOOSING A GOOD LOCATION

- Place the Publisher in a location with adequate air circulation to prevent internal heat build up. You will need at least 24" (61 cm) of overhead space to allow the top cover to open freely.
- Do not place the Publisher near heat sources such as radiators or air ducts, or in a place subject to direct sunlight, excessive dust, mechanical vibration or shock.
C. UNPACKING AND INSPECTION

While unpacking your Publisher, inspect the carton to ensure that no damage has occurred during shipping. Make sure that all supplied accessories are included with your unit.

The following items should be included:
- Optical Disc Publisher
- Gray Plastic Input and Output Bins
- Power Cord
- Kiosk Bin (Not included with 4051 models)
- Cyan, Magenta, Yellow and Black Ink Cartridges
- Replaceable Print Head
- QuickStart Installer Disc
- USB 2.0 Interface Cable (Beige)
- eSATA cable(s) (Blu-ray only)
- eSATA card (Blu-ray only)
- Warranty Card
- This Operator’s Manual, Quick Start Guide and Other Printed Information

Save the carton and packing materials. They will come in handy later if you ever need to transport the Publisher and/or any of its parts and accessories.
D. IDENTIFYING THE PARTS

Front Panel and Top

This illustration shows the Bravo 4102, its Control Panel, Buttons, LED indicator lights, Input and Output Bins and other components.

The Robotic Disc Transporter moves discs from the Input Bin, to a CD/DVD Recorder, to the printer, and finally to the Output Bin.

The CD/DVD Recorder is automatically loaded and unloaded by the Publisher’s Robotic Disc Transporter.

The Recorder Tray Button manually opens or closes the Recorder Tray. In normal operation, the in/out movement of the Recorder Tray is controlled automatically and this button is not used.
The **Control Panel** contains LED Status Lights and Buttons to control the Publisher. The **LED Status Lights** indicate that Power is ON. They also blink in certain patterns to indicate an error or other condition of the Publisher. See Section 4 for a full explanation of the LED Status Light conditions.

The **Power Button** turns the Publisher’s power ON and OFF.

When the front cover is opened, the **Ink Cartridge Button** is used to position the Ink Cartridge Carrier for easy ink cartridge replacement. When the front cover is closed, pressing the Ink Cartridge button will open or close the Printer Tray.

The **Input/Output Bins** are situated under the top cover of the Publisher. The bins will hold up to 50 discs. The right-side bin is the Input Bin for blank media; the left-side bin is the Output Bin for finished discs.

The **Reject Area** is where discs are dropped if they do not pass a software verification test. The discs slide down the ramp out in front of your Publisher.

The **Front Cover** is a durable plastic cover that will protect the Publisher from dust and interference.

The **Ink Cartridge Carrier** holds the print head and the individual CMYK cartridges.

### Rear Panel

This illustration shows the input ports and the power switch found on the rear panel of the Publisher:

![Rear Panel Illustration](image)

- **Power Input Port**
- **Power Switch**
- **eSata port(s) (Blu-ray Only)**
- **USB 2.0 Port**

The **USB 2.0 Port** is connected to an open USB 2.0 port on your PC with the USB 2.0 cable, included with your Publisher.
The **Power Input Port** connects to the included power cable. The internal power supply is auto-switching in the range of 100-240v.

The **Power Switch** shuts off all power to the Publisher.

### E. SYSTEM REQUIREMENTS

**PC:**

Before getting started, it is important for you to verify that your PC meets the minimum system requirements.

- Pentium IV processor or better running Windows XP, Vista, 7, or 8.
- 1GB or greater RAM
- Free hard drive space of at least 10 GB.
- Available USB 2.0 Port. (This looks the same as a USB 1.0 port. Make sure you have a USB 2.0 port for optimal performance)

If your PC does not have at least these minimum system requirements, system performance may not be acceptable.

**MAC:**

- Intel CPU running OS X version 10.6 or higher
- 512 MB RAM
- Free hard drive space of at least 10 GB
- Available USB 2.0 Port
- Do not connect the Publisher to any USB hubs or the USB port on your keyboard. It should be connected directly to an onboard USB 2.0 port.

If your computer does not have at least these minimum system requirements, system performance may not be acceptable.

### F. LOADING MEDIA (DISCS)

**NOTE:** Your Publisher can print directly onto virtually any brand of inkjet printable-surface CD/DVD media. However, different brands of discs have different printable coatings. Because of this, you may need to adjust the printer driver settings to accommodate your specific brand of CD/DVD media. Refer to Section 2B.2 and 2E for further printer driver information.
Due to the wide variety of printable-surface CD/DVD media, you may find that certain brands of discs provide higher print quality than others. For maximum print quality, use CD/DVD media authorized by Primera.

Refer to the following steps when loading discs into the Publisher:

- Open the front cover of the Publisher

- The Publisher will automatically position the cartridge carrier and Robotic Disc Transporter to the center position allowing for easy access to the bins.

- Load the Input Bin (the bin located on the right-hand side of the Publisher) with 50 blank discs and place the bins on the mounting pegs.
You can replace cartridges at any time or wait for the Low Ink Warning to prompt you to replace cartridges. Low Ink Warnings occur at the following levels:

- **10%** - If any cartridge is lower than 10% at the beginning of a job you will be prompted to change that cartridge. At this point you can change or ignore.
- **0%** - If any cartridge reaches 0% during a job you will be prompted to change that cartridge. At this point you can change or ignore. Under normal circumstances this will be your first warning. The 10% warning is only triggered at the start of a job.
- **-10%** - If at any point any cartridge is -10% you will be prompted to change that cartridge. You must change the cartridge to continue.

To change a cartridge, follow this procedure:

1. Open the Cover and press the Ink button. The head carriage will move to the center of the print area for easy access.
2. Remove the cartridge by pressing the corresponding colored tab on the back of the print head. The cartridge will pop up slightly.

3. Remove the cartridge.

4. Locate a new cartridge and remove it from its packaging. Remove the foil outer package and the clear plastic shrink wrap. Also remove the cartridge cap.

**Note:** If you opened a cartridge but are not currently using it you can store the cartridge in the plastic cap shown above to prevent it from drying out.
5. Place the new cartridge into its corresponding colored slot. Press down near the back of the cartridge until it clicks into position.

Important Note: Make sure the cartridge is securely in place. An improperly positioned cartridge will cause no ink of that color to be printed.

D. SETUP THE KIOSK BIN (NOT INCLUDED WITH 4051 MODELS)

Kiosk Mode allows you to use both of the Publisher’s Bins as input, doubling your disc capacity from 50 discs to 100 discs. In this mode, the finished discs will be deposited through the front “reject area” of the Publisher. In Kiosk mode all discs would be ejected in this manner. Rejects can be identified in the stack because they will not be printed. Refer to the following Kiosk Kit installation instructions.
• Attach the Output Bin Holder as shown, aligning the **Locating Tabs** on the Output Bin Holder with the **Slots** located on the underside of the Publisher allowing the holder to hang off the edge of the table. Notice the slots do allow for adjusting the position of the output bin. If your discs are not falling into the bin, you will be able to move the bin slightly to align it.

• Place the Output Bin on the Output Bin Holder as shown.

To enable Kiosk Mode, Open PTPublisher - select **Options** from the Tools menu - find the Options tab - now check the Kiosk Mode box. On a Mac, Kiosk Mode can be enabled in the **Robot Options** menu.
Section 2: Creating Discs

There are two main components to creating discs, printing and burning. For PC, SureThing CD Labler is used to design the image to print on the disc. For Mac, Disc Cover is used to design the image to print on disc. For Mac and PC, PTPublisher controls the recording and allows you to select the image to be printed to your discs.

A. TUTORIAL: COPY A DISC (PRINT ONLY FOR AUTOPRINTER USERS)

Note: PTPublisher functions virtually the same on both Mac and PC. Every effort was made to make them look and function the same. However, due the unique benefits and limitations of both operating systems there are subtle differences. Where important, those differences will be highlighted. In general, these instructions will apply to both the Mac and PC editions.

Note for AutoPrinter Users: Start at step 4 after choosing Print Only from the project starter window.

There are three basic steps to any project. 1. Add Data 2. Add a Print File. 3. Set the number of copies and adjust options (Summary). The instructions below explain how to do the most common project - A Copy Project.

A Copy Project can be used to copy any CD, DVD, DVD-DL or Blu-ray master. This job type reads the master disc from the Disc Publisher drive to the hard drive of your computer. The master is stored in the Global Image format (*.gi) in a temporary location on your computer. PTPublisher uses this temporary file to make all subsequent copies that are requested. The master disc is read only once to create the initial temporary file.

Recommended for: All CD, DVD or Blu-ray content or disc types (Audio CD, Data CD, Software Install Disc, Video CD, DVD Video, Blu-ray Video: CDR, DVD-R, DVD+R, DVD-ROM, DVD+DL, DVD-DL, BDR, BDR-DL, etc.). This is best used for single runs where you will not need to make additional copies of the master disc at a later time.

This project requires a master disc. If you do not have one use another project type. (See Section 3B)
Creating Discs 13

1. Select Copy Project from the Starter Window or the New Project Panel on the left side of the screen. Step one of the Copy Disc wizard will be displayed.

2. You will be prompted to place the disc you would like to copy into the drive inside the Disc Publisher. The tray door will open automatically. Place the disc in the drive and click OK.

3. The Publisher will close the drive and read the contents of the disc. It will display disc type (CD/DVD) and show the size of the disc in Megabytes. Verify this information is correct and click the next arrow to continue.

   **AutoPrinter users Start here after choosing Print Only from the project starter window.**

4. Select the print label file by clicking the select a label button. When you have selected print label file, click the next arrow. There are several ways to select a print file. See the explanations below for more information.

   For any job type you choose you will be prompted to select a label file to print. You may select an existing label, create a label or choose to print nothing. Simply click the next arrow to print nothing on the disc. Otherwise follow the steps below.

4A. Select a Label

   1. Click the browse button to open a browse window to choose your print file.

   2. Double Click on the file to add it to your project. You may add any BMP, JPG, TIFF, SureThing (PC) or Disc Cover (Mac) file. SureThing or Disc Cover files are automatically formatted correctly. All other file types should be 4.72” x 4.72” square. For best print quality the image resolution should be at least 300 dpi.
4B. Create a Label

1. Click the **Create a Label** button to open the SureThing CD Labler or Disc Cover program. These programs will allow you to create a label.

2. Follow the instructions in Section 2C or D to create a label using SureThing or Disc Cover.

3. Once you have designed the label, save it and close the program. A message will appear asking if you would like to use the label file you just created in your current project. Click **Yes** to use it in your project. Once you choose your label a preview will be displayed.

5. After selecting your label to print it is important to check the Printer Settings. These settings are dependent upon the specific discs you are using. Each disc (media) brand or type has a different sized non-printable outer margin or inner diameter. It also has a different printable surface.

For Primera TuffCoat branded discs simply choose your media from the drop down list, the settings will be adjusted accordingly.

**Inner Diameter and Outer Margin (Printable Area).**

If you have other media, you may need to measure the unprintable outer margin and the inner diameter with a clear millimeter ruler to find the correct size to input here.

For the outer margin, measure from the edge of the disc to the beginning of the white printable surface. For the inner diameter measure from one side of the unprintable hub to the other. The unprintable inner diameter will almost always be larger than the center hole of the discs (15mm).
Print Quality. All Primera media is automatically defaulted to the best print quality. Other media may also accept the best quality setting. However, with some media you may have to print at a lower print quality to eliminate smudging and bleeding. Some lower quality media cannot hold all of the ink that is printed at the highest quality settings.

Click the next arrow.

Note: Additional print settings are explained in Section 2E.

6. The third and final step of any project is the summary screen. On this screen you can review the data and print selected for the project, set the number of copies, adjust burn options and name the job. Click the Options button to access burn speed and other options. If you do not adjust the project options, optimal settings will automatically be selected for you.

Click the "Go" button to start the job.

B. USING PTPUBLISHER

PTPublisher allows you to record and print CDs, DVDs, and BDRs (Blu-ray) using a variety of project types described below. When the software is opened these projects will be available from the main starter menu. You can also access them by clicking New Projects on the left navigation area.

B.1 Project Types

Note: “Print Only” Project is the only project available for AutoPrinters.

Copy Project

A Copy Project can be used to copy any CD, DVD, DVD-DL or Blu-ray master. This job type reads the master disc from the Disc Publisher drive to the hard drive of your computer. The master is stored in the Global Image format (*.gi) in a temporary location on your computer. PTPublisher uses this temporary file to make all subsequent copies that are requested. The master disc is read only once to create the initial temporary file.
Recommended for: All CD, DVD or Blu-ray content or disc types (Audio CD, Data CD, Software Install Disc, Video CD, DVD Video, Blu-ray Video: CDR, DVD-R, DVD+R, DVD-ROM, DVD+DL, DVD-DL, BDR, BDR-DL, etc.). This is best used for single runs where you will not need to make additional copies of the master disc a later time.

The project requires a master disc. If you do not have one use another project type.

Data Project
A data disc project allows you to create a data disc on a CD, DVD or BDR using files on your hard drive. You can replicate the file structure on your hard drive or you can create your own customized file structure.

Recommended for: Use the data disc job to create software installation discs, or data discs containing image files, presentation files, PDFs, documents, MP3s or any other file type. Data discs can generally ONLY be read by computers.

Audio Project
This project allows you to create an audio CD using WAV, MP3, AIFF or WMA files. Note: this procedure is not for copying already created and mastered original audio CDs. If you have already created a master audio CD in another application or this application and you would like to make additional copies, please use the Copy Project.

Recommended for: Creating Audio CDs

Video Project
This project involves extracting the Audio_TS and Video_TS folders from the master DVD or directing your DVD authoring software to output into Audio_TS and Video_TS folders instead of burning a master disc. For Blu-ray Video, this method involves extracting the Blu-ray folders from the master DVD or directing your Blu-ray authoring software to output into Blu-ray folders instead of burning a master disc. Note: The PTPublisher software was not meant for authoring DVDs or Blu-ray. You must use another software to burn a master DVD first. Make sure that disc plays and the menus work on all systems. You may also copy a master DVD using Copy Project or Image Project. However, the video project is the recommended method.
Recommend for: This method is especially useful if you are having compatibility problems with the formatting created by the DVD/Blu-ray authoring software or with the media type of the master disc. This method removes some potentially complicating variables from the DVD/Blu-ray Video creation process. This method eliminates the need for a master disc. Error or incompatibilities can be introduced into your master by the drive burning the master, the disc the master is burned on or the software burning the master. Instead, masters can be stored on a large hard drive. This allows you to burn additional copies at any time without locating the master. If a backup strategy is employed, hard drive storage is more reliable over the long term since it is not susceptible to scratching like a master disc.

Image Project

The Image Project allows you to copy any CD, DVD, or BDR master. You can use an existing image or create an image and then use it in the project. The master disc is read from the specified drive to the hard drive of your computer. The master is stored in the Global Image format (*.gi) in a user specified location on your computer. PTPublisher uses this file to make all subsequent copies that are requested. The master disc is read only once to create the initial file.

Recommended for: All CD, DVD or Blu-ray content or disc types (Audio CD, Data CD, Software Install Disc, Video CD, DVD Video, Blu-ray Video: CDR, DVD-R, DVD+R, DVD-ROM, DVD+DL, DVD-DL, BDR, BDR-DL, etc.). This is best used for jobs that are repeated on a regular basis where you will need to make additional copies of the master disc at a later time. This project type stores the master on your hard drive. This saves the time it takes to read in the master and reduces the possibility of defects being introduced into the master disc.

B.2 Steps to any Project

Step 1: Add Data

Depending on your job type this step will be different. You may choose your master, choose data on your hard drive, choose tracks to your audio CD, choose your disc image or DVD or BDR video folders.
On most job types a volume label can also be created at this step. This is the label that will appear when this disc is inserted into a computer drive.

When you have selected the data you would like to burn click the next button.

**Step 2: Add Print**

If you want something printed on your disc, this is where you choose an existing label or create it. Follow these steps.

*To select an existing label:*

1. Click the browse button to open a browse window or drag and drop files to the print file box or click the drop down arrow to choose previously used labels.

2. Choose any supported file types of JPG, BMP, TIFF, SureThing (PC) Disc Cover (Mac). Files should be 4.72" (120mm) square. For best print quality the image resolution should be at least 300 dpi. Non-conforming files will be stretched or increased in size to fill the full size of the disc.

3. Once the print file is selected a preview will be displayed.

4. At this point you may choose to move on to the next step by clicking the next arrow. However, there are print quality and print area settings that you may want to adjust.

5. Several preset media types that correspond with the media available at our webstore can be selected on the Media drop down box. When you select a media type from this box the Print Quality, Outer Margin and Inner Diameter are automatically adjusted to fit that media.

6. To manually set these settings simply edit them. The media type will automatically change to Custom. You can save your adjusted settings by typing the name of the profile and clicking Save. This name and the associated settings will now be available to choose in the media drop down box.

Below is a description of each of the available settings:

- **Quality.** There are several choices here that correspond to the speed of the print and the saturation of the image. Higher quality = slower print speed and more vibrant and crisp prints.
• **Outer Margin.** Discs from other manufacturers vary widely regarding how far the printable surface extends to the edge of the disc. Measure the distance from the edge of the disc to the start of the white printable area. This will be between 0 and 2 mm in increments of .1mm.

• **Inner Diameter.** Discs from other manufacturers vary widely regarding how far the printable surface extends to the inside of the disc. Measure the distance from one side of the inner non-printable center hub to the other. This will be between 15 mm and 50 mm displayed in increments of .1mm.

**Note:** Additional print settings are explained in Section 2E.

**To Create a new label:**

1. Click the Create Label button.
2. The label design application SureThing (PC) or Disc Cover (Mac) will open.

   Design your label using the included backgrounds and clipart. You may also add your own image, add text and any other design features.

3. Save your label by going to the File menu - Save as.
4. Close SureThing or Disc Cover.
5. You will be asked if you would like to use the label you just created in your current project. Click Yes.
6. You may now choose to adjust print settings as described above.

**Step 3: Start Project (Summary - Settings)**

In this step you can verify data and print information and set the number of copies. Optionally you may choose to edit burn settings. However, the default settings are optimized to give you the best quality burn. Simply click Go to start the job.

A summary of all the options on this step is listed below.

**Project Summary**

This areas displays information about the data you have chosen, a thumbnail and file name of the print file you have chosen and picture and description of the Disc Publisher Robot you have chosen. If any of this information is incorrect, use the back arrow at the bottom of the screen to go back to appropriate window to correct it.
• **Change Robot**. This is only available with multiple robots connected. Use this option to change the robot to which this project will be sent.

• **Drives**. With a 4102 connected you can choose to burn to both drives or the top or bottom drive only.

• **Protect Video with PTProtect (PC Only)**. This is only available in the DVD Video and ISO image Project with purchase of PTProtect USB dongle. See the PTProtect section for more information.

• **Add to Project Set (PC Only)**. This option allows you to add a project to a new or existing project set. A project set is a group of projects that you can save together. See Section 2 B.8 for more information.

• **Save Project**. At the top of the summary window you can type the name of your job and then click save to save it anywhere on your computer.

A project file is a small file that holds the locations of files to be burned, the location of the print file to be printed, and any specific project settings such as burn speed and number of copies. Note: A saved project file does not include the data to be burned or the print file to be printed. If these files are moved or deleted, the project file will need to be edited to reflect these changes.

• **Schedule Project**. Click this button to schedule this job to run daily, weekly or monthly at a specific time. For more information on this topic see Section 3B.5.

**Project Options**
For any job type you can click on the Options button for additional options for that job. Below is a description of all Project Options. Not all options are available for all Project Types. If the options are not available for the chosen project type, they will be hidden. If you would like these settings to be the default for all projects of this type click Save as Defaults.

• **Recording Speed**. Set the recording speed with this option. The fastest recording speed is determined by the lowest maximum speed of the blank media or the drive. For example: The “fastest” speed in a 20x max drive with 16x max media would burn at 16x. In many cases a slower speed should be selected to achieve the least number of rejected discs.
• **Recording Type.**

  *Track-at-Once.* This is the default. For track at once, the laser is turned off after each track, which produces a two-second gap. The track-at-once feature, enables songs and data to be written at different intervals. The lead-in sectors that are written at the beginning of each session contain the location where additional data can be placed on the disc.

  *Disc-at-Once.* If this option is checked, the lead-in, all the tracks and lead-out are written in same action. The laser is kept on for the entire session.

• **Closed-Finalized/Open.** A closed disc means no additional data can be added. If the disc is left open additional data can be added in another session.

• **File System.** The file system is the method by which the files and folder are arranged on the burned disc. Joliet is best for most CD burning applications. UDF 1.02 is best for DVD burning. UDF 2.6 is used for Blu-ray. The recording engine can also add a bridge which effectively adds another file system to the disc. UDF 1.02 with a Joliet bridge is the default.

  Most of the differences between file system types relate to file name length and character restrictions and folder level depth. ISO is the most restrictive and oldest and UDF is the least restrictive newest file type. The complete list of specifications for each is several hundred pages. Macs and PCs can read both types.

  If you would like to make your burned disc compatible with very old operating systems or other less popular operating systems use the ISO system.

• **Test Record.** If this option is checked the recorder tests a disc for record ability before burning. The drive laser is set to read power and the entire surface is scanned for errors. This takes the same amount of time as recording. (DVD+R media cannot be tested) This options can not be used in combination with normal recording or verify.

• **Verify.** If this option is checked, it compares the copy with the master bit for bit. If it finds a discrepancy it rejects the disc. Verify is an extremely high quality standard. If the disc is audio or video, the discs may still be playable and the errors may not be detectable by human eyes or ears.
This operation may be useful to verify software installation discs where it is extremely important to have accurate copies of all installation files. Checking this option will double the time it takes to record each disc.

- **Set Time and Date to Mastering Time.** If this option is checked, all files on the disc will automatically be set to the current time and date.

### B.3 Robot Options/Bin Selection

Double click on the bin icons at the bottom of the screen to access these settings.

Here you can designate the type of media in the left and right bins and finished bin location.

**Kiosk Mode (Not available with 4051 models).** By default, PTPublisher assumes that discs are loaded into only the right bin. It picks from the right bin and places completed discs in the left bin. Check Kiosk Mode to make the robot pick blank media from both the right and left bins. Finished media will be placed in Kiosk bin. Kiosk Mode still requires the same type of media in both the right and left bins. See Section 2D for instructions on setting up the Kiosk bin.

**Bin Selection (Not available with 4051 models).** Enable Bin Selection to use different types of media in the left and right bins. Check the box and set the media type to one of the available options. Once Bin Selection is enabled the contents of the bin will be reflected next to the bin icons. To take advantage of this feature choose a specific type of media on step one of the data project. Other project types will automatically select the correct type of media. When you queue multiple projects with different media types the robot will now choose from the left or right bin depending on what media type is selected in the project and set for the bin. All finished discs will be placed in the kiosk bin.

**Note:** PTPublisher has no way to verify if the actual discs loaded into the bin are CDs, DVDs, DVD-DL or BDR. It is up to the user to make sure the designated media is in the correct bin.
B.4 Publisher Status

The status window is automatically displayed when a job starts. You may also access it at any time by clicking the More Status link under the picture and description of the robot connected. Publisher Status is only available if the Publisher is connected.

- If no errors are present, the green check button will be displayed with a Ready indication to the left.
- If errors are present a red exclamation button will be displayed with the error explained to the right. At times the entire error will not be visible. Click More Status to view the complete error.

The Status page displays Drive Status, Printer/Robot Arm Status, and Project Status.

Drive Status shows the current status of the drive during a job. The recording progress is displayed on the progress bar along with the total size of the burn and the current amount burned.

Printer/Robot Status shows the current status of the printer if it is printing or the robot if it is moving discs.

The Project Status area of the Publisher Status window shows the current status of the job such as what disc number is printing and burning of the total number of discs to produce. From here you may also view a detailed log of the current job, view a log of previous jobs and abort currently running jobs.

To abort a currently running job, click the Abort button. The publisher will finish its current robotic command and then stop the job.
Queue Project. To queue another project to run after the current one is finished simply setup the project as you normally would. When you get to the third step of the project setup wizard, if a project is currently running, a Queue button will appear instead of a Go button. Click it to queue the job.

B.5 Backup Project (PC Disc Publishers Only)

To create a new backup project you must setup a data project and then schedule it. Follow these steps:

1. Choose Data Project from the project starter window.
2. Add the files or folders that you would like to backup. Typically there will be more data to backup than will fit on any one CD, DVD etc. If that happens you will receive a warning message and the data bar at the bottom of the screen will turn red.

To resolve this issue you may choose to span the data over several CDs or DVDs or change the media to a different type with more data capacity.

If you choose to check the span disc box you do not need to change media type. A Span Report button will appear which will tell you how the data will be distributed over the chosen media type.
Regardless of the media type selected for backup projects it is recommended that span discs be checked to accommodate future backups of the same files/folders which may be larger.

**Important Note:** It is not possible to span a single large file over multiple discs.

Using the media drop down list, you may also choose to change the media type to one with more capacity. The data bar will change from red to green.

**Note:** Changing the media type only changes the media that the software expects. It is up to the user to make sure the selected media is in the correct bin.

3. Once you have selected the data click the next arrow to add a print file. There is a print template that has been designed for backup projects. It is recommended that this template be used. Check the "Use Print Template" box.

Title and description fields will appear below it. Fill out these fields with information pertaining to the backup project. Date, time and the number of discs in the backup set will automatically be printed on the disc. Click the refresh button to view your changes in the preview.
4. Click the next button to display a summary of the project. Click Schedule Project to convert this data project into a backup project. You will be prompted to save your project. Do not move projects once you have saved them. Always choose only one copy even if your project will be spanned across multiple discs.

Once the project has been saved the Schedule window will appear. Set the frequency of the backup and the time of day. Click Schedule.
The Scheduled Projects window will appear. Check the box next to the backup project you would like to run. Click Run Now to run it for the first time now. Otherwise, the backup project will proceed at the scheduled time.

You must keep the PTPublisher software open, the Disc Publisher turned on and the discs loaded for the automatic scheduled backup to occur. If you would rather not do this you may also check None on the Schedule window to run the backup project when you choose. This will add the backup project to the Scheduled Projects list and allow you to run it whenever you click the Run Now button.

You can access the Scheduled Projects list at any time by choosing Advanced Project from the project starter window. Choose Backup Project from the sub menu. Here you can view all scheduled projects, edit the project or change the frequency or time of the automatic backup.

**Note:** All backup runs are full backups. PTPublisher does not do incremental or differential backups by searching for new or changed data.

### B.6 Rip Audio CD (PC Disc Publishers Only)

This project allows you to rip music to your hard drive in MP3 or other formats using iTunes® or Windows Media Player.

1. To rip an Audio CD to your iTunes database or Windows Media Player database choose Advanced Projects - Rip Project.
2. Choose whether to rip to iTunes or Media Player.
3. Load the Audio CD in the right bin of the Disc Publisher.
4. Click Go to start ripping CDs. Follow any onscreen prompts regarding settings that must be set before you being.

**Note:** The actual ripping process is completed by iTunes or Media Player. Please set all settings regarding the rip format (mp3, wav, wma, etc.), rip location, rip quality (kbps), etc. in Media Player or iTunes.
**Tips:**

1. When loading discs, do not stack multiple albums from the same artist together.

2. For best results rip audio into an empty iTunes or Media Player database.

**B.7 PTProtect (PC Disc Publishers Only - Requires separate purchase of USB dongle)**

PTProtect allows you to copy-protect any DVD Video and mass produce protected discs using the PTPublisher software and a Primera Disc Publisher.

You can protect an existing Master DVD by first converting it to an ISO image using PTPublisher or you can protect a DVD that is stored on your hard drive as VIDEO_TS and AUDIO_TS folders. Instructions for each of the two methods are found in the instructions with the PTProtect dongle or in the PTPublisher software help file.

To protect DVDs you must first insert the PTProtect USB Dongle (100, 250, 500, 1000 or 5000 protections) into a USB port on the same computer that the Disc Publisher is connected to. Once you insert the dongle it will appear in My Computer as the next available drive letter with a Volume Label as "PTProtect."

When PTPublisher is launched the PTProtect option will be enabled. The number of protections enabled will be visible on the Summary screen (Step 3) of the DVD Video Project or Image Project.
Note: You will receive 3 free protections before the dongle is connected. After the free protections are used the PTProtect option is still visible but not selectable.

B.8 Projects Sets (PC Disc Publishers Only)

A project set is a group of projects that you can save in specific order and run once or multiple times. You should use this feature if you often run a group of projects together. For example, you might package an audio disc and a DVD together as a set so you would always need the same number of both. Just add both projects to a project set and start them both with a single Go command. Or if you package six discs together as a set you can create a project for each volume, add them all to a set and click Go to start them all. You can even collate by running the set multiple times.

There are two ways to create a project set.

A. Add existing saved project to a new project set.
1. Go to Advanced Projects - Project Set
2. You will be prompted to name your project set.
3. The projects sets screen will appear.
4. Click Add Project to browse to an existing project.
5. Add additional projects sets in the same manner.

B. Add a currently open project to a new or existing project set.
1. Setup your project just as you normally would.
2. On the summary screen, save your project.
3. Click on the Add to Project Set drop down menu.

4. Choose New Project Set or existing project set.

5. The project set window will now open.

6. Add additional project sets in the same manner.

7. Rearrange or delete project sets using the arrow icons or the delete icon.

8. Run the project set multiple times by using the toggle at the bottom of the window.

9. Click Go to start the project set.

**Note:**
1. Open the project to adjust the number of copies or any other setting in the project. Re-save the project when you are finished.

2. Copy projects and Rip Audio projects cannot be added to a project set.

3. Multiple drive robots may not always output discs in the intended order.
C. CREATING A PRINT LABEL USING SURETHING (PC)

The SureThing Disc Labeler software included with your Publisher is a great tool for creating professional looking discs. You can use SureThing's Smart Designs to quickly label a disc, or easily import your own design in many popular file formats. The Help section included with the software will provide complete instructions on all the features in this package. (Go to the Help Menu - Choose Contents) The following is a tutorial on creating a basic disc design:

1. Open the SureThing program. Choose the 120mm DiscTemplate from the window that appears.

2. Open the background panel by clicking the arrow on the background button. Add your own background to the label by choosing Select Background.

3A. Browse to the location of your background image. To avoid skewed or blurry printing make sure your image is 120mm square and of sufficient resolution. We recommend 300 dpi.

3B. Instead of your own background, you can also choose from several included SureThing backgrounds. To choose one of these images click the SureThing Background button in the Browse window that appears when you click Select Background. Also, you can easily toggle through the backgrounds by using the toggle bar below the label. Backgrounds are controlled by the far left toggle button.
4A. Open the text panel by clicking the arrow on the text button. Add text by selecting one of the options below. To create text that follows the curve of the disc choose Add Circular Text.

4B. You may also choose from several SureThing smart designs. These design templates automatically position your text and use certain text effects to give your label a professional look. You can easily toggle through smart designs by using the middle toggle button on the toggle bar below the label.

5. Finally, open the picture panel by clicking the arrow on the Pictures/Clipart button. Add any logos, graphics or symbols to the label. These graphics will appear on top of the background image. You can size them appropriately by dragging the corner of the selected graphic.

6. When you have completed the design work save your label by choosing Save Project in the Actions panel.

**D. CREATING A PRINT LABEL USING DISC COVER (MAC)**

The Disc Cover Disc Labeler software included with your Publisher is a great tool for creating professional looking discs on a Mac. You can use Disc Cover’s backgrounds and clipart to quickly label a disc, or easily import your own design in many popular file formats.

The Help section included with the software will provide complete instructions on all the features in this package. (Go to the Help Menu - Disc Cover PE Help) The following is an overview of the basic components of the software:
1. Open the software by clicking the Create Label button on the Add Print File step of PTPublisher. There is no way to open Disc Cover PE outside of the PTPublisher software.

2. To add a background from Disc Cover, click the Gallery button on the top tool bar. On the image above, the Gallery button is the highlighted center color wheel button on the left side of the top tool bar.

3. Choose Backgrounds from the drop down box. Click the design that you would like as your background. Use the scroll bar to view all of the designs.

4. You may also select an image or design from your hard drive as long as it is a supported file type such as TIFE, JPG, BMP or PDF. Go to the Insert Menu - Select Image - Choose From File...
5. Once your image or background has been selected you can add text or other design elements using the buttons on the tool bar or the Inspector. Below is a short description of each of the important buttons.

- **Import** - Import song titles from iTunes or pictures for a collage from iPhoto®.
- **Gallery** - Choose a Disc Cover backgrounds or several backgrounds to make a collage. Create your own backgrounds and add them to the Gallery.
- **Clipart** - Choose from a wide selection of categorized clipart. After selecting this button, click the dropdown that appears to see all categories.
- **Selection** - Resize or move text, images or shapes with this tool.
- **Text** - Create a standard text box.
- **Circular Text** - Create circular text that follows the contour of the outside or inside of your disc.
- **Zoom** - Zoom out or in.
- **Color** - Change the color of the selected object with this tool.
- **Font** - Change the font of the selected text or circular text object with this tool.
- **Inspector** - Click this button to open or close the Inspector window. The Inspector window includes advanced options that allow you to change the properties of your template, change size or position of the objects, add effects, edit transparency, change text properties and align objects. See the next step for more information.
6. Once you have several objects on screen you may choose to use the Inspector tool to edit advanced object properties. Select the objects you would like to edit and then click on one of the six buttons on the top of the inspector. Four are shown below. See the description of each understand what options are available on each.

- **Design Element** - Switch to a new template, edit the current template, create your own.
- **Geometry** - Precisely move, resize or rotate selected objects.
- **Fill and Shadow** - Add shadow, change thickness or color of geometric objects.
- **Image** - Add transparency or a gradient to images, clipart or backgrounds.
- **Text** - Change line spacing, character spacing, fonts, size, or justifications of any selected text object.
- **Alignment** - Align or distribute multiple text objects.

7. Many other options such as changing the order of objects, (send to front, send to back) and exporting in other file formats are available from the Disc Cover menus.

8. Finally, save the design by going to the file menu - save as. Quit Disc Cover by choosing Quit from the Disc Cover PE menu. PTPublisher will ask you if you would like to use the design you just saved in your project. Choose Yes.
E. ADVANCED PRINTER SETTINGS

Advanced Printer Settings can be accessed from the Add Print File Step in either PTPublisher for Mac or PC.

All available settings are displayed in the Printer Settings area on this screen.

Below is a description of each.

**Print Quality**

This setting affects the quality and speed of the print. Ink consumption is only slightly increased as you increase the quality. The default setting of medium is sufficient for most images. If you are printing large areas of solid color you may find that you must increase the quality to reduce banding.
Ink Cartridge

Color + Black is best for images that have large areas of black graphics or text. Although you can print these same images with just the color cartridges, often the blacks will look darker with this setting. To make sure the black cartridge is used, the black areas of the source image must be 100% black. If SureThing or Disc Cover is used to create black text or graphics, you can be assured that the black areas are 100% black. However, if you are using a JPG image, even areas that look black may not use the black cartridge since the JPG format compresses the image.

Color Only is the default setting and is best for most images. With this setting, the printer only uses the color cartridges to produce all colors including gray scale black and white images.

Monochrome Black is for images that have large black areas or black text. This will ensure that no color ink is being used.

Saturation

This option controls the ink saturation of the printed image. When printing onto the printer manufacturer's TuffCoat media, this option can be left at its default setting of 100%. When printing onto other brands of printable media, you may need to adjust this control in order to optimize the ink saturation for the printable surface of your specific media. Click on the up and down arrows to change the ink saturation setting. Lower numbers reduce the overall ink saturation, while higher numbers increase it. If discs do not seem to be drying completely, it may be necessary to reduce this value.

Outer Margin

Adjust this value to print all the way to the outer edge of a disc. This is useful if you are printing full coverage images. The lower you set this value, the farther to the outer edge of the disc you will print. Please note that with most media, the printable surface does not extend all the way to the edge of the disc. Because of this, you will not normally set this value to zero. You may also want to adjust the inner diameter setting. To use the preset outer diameter setting for Primera media, select the media type from the drop down box at the top of the printer settings area.
Inner Diameter

This value changes the size of the non-printed center. Larger numbers cause the non-printed center to be larger and smaller numbers make the non-printed center smaller. This number is incremented by 0.1mm so a change of 10 for inner diameter changes the diameter by 1mm. Set the diameter to 230 for Primera TuffCoat media. To use the preset outer diameter setting for Primera media select the media type from the drop down box at the top of the printer settings area.

Color Mode

*Best for Graphics* mode is best used for graphical images where accurate color reproduction is not as essential. Images printed in this mode will look more vibrant because more ink is being used to produce them. However, printing images of people may produce skin tones that have a reddish tint.

*Best for Photos* mode is best used for photographic images where accurate color reproduction is very essential. Images printed in this mode will look lighter than those printed in Photo mode. Skin tones especially will look more natural in this mode.

**NOTE:** Exact color matching of the printed discs to the screen may never be possible since there are factors that affect this out of the drivers control. The surface of the disc reacts with the ink in the cartridge to produce the color. For this reason, when printing the same image to different types of discs with different surfaces the printed output can look entirely different.

Color Table

Adjust the Color Table setting to adjust the color matching for any image. There are six different color tables to choose from. Since color matching is greatly dependent on the media being printed on, there is no reliable way to differentiate between these tables. Experiment with all the tables and choose the one that works best for you.
Printer Utilities and Cost Estimator

Printer utilities and the cost estimator will be available if you click the info icon. From here you can view ink levels, cost per disc, change cartridges, clean the print head/cartridges or run the calibration utility. More information on each is below.

Cost Estimator

After printing one disc of any design the Cost Estimator can be used to estimate the cost per discs. Ink cost is automatically and continuously calculated based on the black and color cartridge costs entered. Only the last printed label cost is displayed. For reference, the print file and date of last print is displayed at the top of the window.
You will need to Set the Cartridge Cost first before receiving a cost per disc. Adjust the cartridge costs according to the actual price paid. The estimate does not take currency into account so you can assume that whatever value you entered is displayed in your currency.

Save a screen capture of the cost by clicking the disc icon.

Print a screen capture of the cost by clicking the printer icon.

**Important Note:** The cost per disc represents the average cost per disc over an entire run of labels. This means that the per label cost will decrease and become more accurate as the number of labels printed increases. This is because the ink that is used for initial job starting cartridge maintenance is divided into a larger number of labels.

**Calibrate the Disc Publisher**

Several advanced calibrations can be performed with this utility. Under normal circumstances you would have no reason to perform any of the calibrations since all of them are factory calibrated. However, if the Disc Publisher is having trouble picking from any location, the calibrations available here can be used to correct this problem.

**Cartridge Alignment**

The Cartridge Alignment prints a test print and then automatically scans the print to configure your printer for bidirectional printing and to align the color and black cartridges for Color+Black printing. It is important to perform this calibration every time you change a cartridge. If you forget to perform this calibration you will be prompted to do so before your first print from the new cartridge.

**Center Print Image**

**NOTE:** Your printer comes from the factory pre-calibrated to print the image to the center of the CD. You can use this adjustment if you need to fine-tune this location.

If you ever wish to verify your factory-calibrated Vertical and Horizontal calibration settings, you can run a simple calibration procedure to assure that your images will be centered when printed on a CD. To do this, refer to the following steps:
1. Click Center Print Image in the Printer Settings Window.

2. Click Start Auto Calibration to begin printing the calibration test print.

3. When the print is complete, rotate disc 180° and put the disc back in the input bin and repeat step 2 using the same disc.

4. When the second run of the print is complete, you should have a test print that looks similar to the following:

5. Along the Vertical axis of the printed disc, find the number whose lines touch. For example, in the above illustration, Enter the number 2 into the Vertical box of the Calibration window and 0 for the Horizontal axis.

6. Select the OK button. Your images should now be centered when printed on a disc.

**Note:** If you think you know what values to enter for the horizontal and vertical fields you may skip the Auto Calibration and enter the values directly by clicking Manually Set Values.
Change Cartridge(s)

Select the Change Cartridge(s) button to install a new ink cartridge or to switch back and forth between previously used cartridges.

Clean Print Head

If the printer has been idle for a long period of time you may start to experience some drying of ink in the tiny nozzles that make up the print head. Clicking the Clean Print Head button will cause the Publisher to pick a disc and place into the printer tray. The Publisher will then print a simple pattern that will flush ink through the nozzles. *Multiple Clean Print Head prints may be necessary!* If the nozzles are not fully clear after a few cleaning prints, it may be necessary to remove the cartridge and manually clean the print head. See Section 3D.

F. LABEL DESIGN REQUIREMENTS FOR OTHER GRAPHICS PROGRAMS

Other graphics programs can be used to design labels and print directly to the Publisher.
When printing and burning through the PTPublisher software your Publisher will support the following additional standard label image file formats: BMP, TIFF, JPG, GIF, PNG and PRN. These formats can be exported from most original graphics formats such as Adobe Photoshop or Illustrator.

When creating images in other graphics programs we recommend creating a 4.72 x 4.72 square image that has a 300 dpi resolution.

42 Creating Discs
Section 3: Maintenance and Troubleshooting

The Publisher is designed to operate for extended periods of time with very little attention. In fact, no regular maintenance is recommended other than cleaning the outside case.

**NOTE:** Do NOT attempt to oil or grease the Publisher’s Robotic Arm shaft or other components. You will likely cause more harm than good! Any moving parts are designed to operate for the life of the machine with no additional lubrication required.

### A. INTERPRETING THE PUBLISHER’S INDICATORS LIGHTS

The Power and Busy LED indicator lights located on the top of the Publisher can tell you a lot about what is happening inside the Publisher. To accurately interpret what it means when these lights are on, off, or flashing, please refer to the following:

<table>
<thead>
<tr>
<th>Ink Cartridge LED</th>
<th>Power LED</th>
<th>Publisher</th>
</tr>
</thead>
<tbody>
<tr>
<td>off</td>
<td>on solid</td>
<td>Is ready to receive job</td>
</tr>
<tr>
<td>on solid</td>
<td>on solid</td>
<td>Has received a job and is waiting for the Robotic Disc Transporter to load a disc</td>
</tr>
<tr>
<td>both lights are slowly blinking alternately with one another</td>
<td>Waiting for a cartridge to be installed and the lid to be closed (See Section 2-A)</td>
<td></td>
</tr>
<tr>
<td>both lights are blinking alternately followed by only the left light intermittently blinking for approximately 30 seconds</td>
<td>The Publisher is initializing. You will see this pattern when the Publisher is first turned on. Wait until the lights stop blinking before opening software or starting jobs.</td>
<td></td>
</tr>
<tr>
<td>flashing rapidly on solid</td>
<td>The printer tray or ink cartridge carrier has stalled. Press the Ink button to retry the operation.</td>
<td></td>
</tr>
</tbody>
</table>
B. INTERNAL BLUE LED LIGHTS

The Publisher’s Internal LED lights provide useful light and also can provide status information.

By default, the lights are set to Flash Enabled. This condition will flash the internal LED lights off and on during any error condition.

- A Low Ink Warning error will slowly dim the LED lights.
- A flashing LED light indicates a general system error that needs attention such as a missing ink cartridge, out of discs or a mispick. Refer to the PTPublisher software for instructions on how to correct the problem.

The following internal LED light states can be selected in the PTPublisher software.

- Flash Enabled (Default) - Errors are indicated in the manner described above.
- Always On - No errors are indicated.
- Always Off - No errors are indicated.

To access these settings on a PC go to the Tools Menu - Options. To access these settings on a Mac go the the PTPublisher Menu - Preferences.

C. TRANSPORTING THE PUBLISHER

To prevent damage to the Publisher’s robotic arm during shipment, it is important to properly secure it.

To prepare for transport, remove the ink cartridges and disc holders, close the front cover and then do the following:

1. With the front cover closed, switch off power to the unit.
2. Press and hold the Cartridge Button.
3. While continuing to hold the Cartridge Button, switch on power to the unit.

Continue to hold the Cartridge Button for five seconds. After several more seconds, the robotics will undock and the arm will lower. Power will shut off automatically once the robotics are in transport position. If you have the cardboard spacer that was shipped with the unit, replace the spacer inside the unit and close the cover. If you don't have the cardboard spacer, secure the arm and cartridges to the sides of the unit with tape and close the cover.
D. CLEANING THE PRINT HEAD

It may be necessary to clean the print head nozzles if you notice reduced print quality, missing colors or if you suspect an cartridge nozzle has become slightly dried out or clogged. Try the following solutions:

1. **Secure Cartridges.** Make sure the corresponding cartridge is snapped into place. Remove and reseat the cartridge to make sure an air tight connection has been made. You should hear a "click" when the cartridge is installed properly.

2. **Clean the Copper Contacts.** Ink over spray can build up inside the printer over time causing interrupted electrical signals. Remove the printhead and clean the copper contacts on the printhead carrier and the printhead.

3. **Clean the Printhead.**

   **DO NOT** touch the printhead nozzles with a tissue or paper towel. This can damage the nozzles! This may be different that previous printers. Instead used the methods described below:

   1. Open PTPublisher.
   2. Go to Tools menu – Choose Printer Properties/Tools and click Clean Print Head.

   You will need an inkjet printable disc in the input bin for this process. You may need to repeat this process up to 4 times depending on how clogged the printhead is. Only repeat the procedure if you start to see improvement after each clean print.

   During this process the printer will make several loud whirring noises. This is normal! This is the sound of a pump forcing ink through the nozzles. If you do not hear this sound, the clean purge print did not complete successfully. Try again.
4. Preventing clogged nozzles

Clogged nozzles on the printhead can be caused by non use of the printer for extended periods of time. Follow these guidelines:

- Always keep the 4100 plugged in and turned on. The printer will do periodic maintenance to make sure the nozzles do not clog.
- Never store a used printhead outside of the printer. The nozzles will dry out with exposure to air. If you must store a printhead outside of the printer, place full or empty cartridges in the printhead and put the entire printhead and cartridges in a sealed plastic bag.
- Use the printer regularly!

5. Quality Setting. Change your quality setting. The lowest (and fastest printing) quality may not be sufficient for many photos or graphics. The highest quality setting may cause ink to bleed on certain graphics in combination with certain label stock. Increasing the quality increases print time because the printer makes more passes over the media.

6. Replace Printhead/Cartridge. The cartridge may be empty or defective. The printhead nozzle for one color could be clogged. The fastest way to diagnose a quality problem is to have backup printheads and cartridges available for comparison testing. If one color is missing, replace that color cartridge(s). Next try replacing the print head.


If you think your cartridge/printhead is defective, please contact tech support to arrange for a replacement. Tech support may ask you to perform troubleshooting before sending a replacement cartridge or printhead.

Notes on Ink/Printhead Replacement

- All replacements for defective cartridges or printheads must be processed through Tech Support.
- To receive replacement cartridges, you may be required to send in your defective cartridges/printhead.
- Tech Support will perform the cleaning procedures and tests mentioned above on all cartridges/printheads received.
- Tech Support will not replace cartridges with less than 50% ink remaining.
• Printheads with over 10,000 prints will not be replaced for free under any circumstances.
• Printheads with under 10,000 prints may be replaced depending on the description and circumstances of the failure at the discretion of Primera Tech Support.

Notes on Printhead Life
The estimated printhead life is approximately 10,000 prints using a 100% coverage label. The number of prints you can expect to receive from one printhead varies from printhead to printhead. This is not a guaranty that the printhead will always last 10,000 prints. There are many variables that could extend or shorten the life of the printhead.

To ensure uninterrupted printing capability, purchase a backup print head now. You can purchase a printhead from www.primerastore.com

Semi-Permanent Print Head - Part Number 53471

E. REPLACING THE PRINT HEAD

Replacing the printhead may become necessary if you notice a gradual decrease in print quality, if one or more colors are missing from a print or if some of the print nozzles are still clogged after repeated manual cleanings as described in Section 3D.

Follow this procedure:
1. Open the Cover. Press the Ink Cartridge Button.
2. Remove all cartridges. Press the release tab at the front of the carriage to release the latch.
3. Remove the print head. Grasp the print head near the back as shown in the illustration.

4. Locate a new print head. Before placing the new print head in the carriage clean the copper contacts on the carriage and the print head with the alcohol wipes included with the new print head.
5. Close the latch until you hear a click.

6. Replace the cartridges.

F. TECHNICAL SUPPORT

If you have difficulties operating your Publisher, the procedures in this manual and the software User's Guide should, in most cases, solve the problem. If you still have difficulty, contact the technical support via one of the methods listed below.

<table>
<thead>
<tr>
<th>Source</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primera Knowledge Base</td>
<td><a href="http://www.primera.com/kb">www.primera.com/kb</a></td>
</tr>
<tr>
<td>PTPublisher Software Help files</td>
<td>Open the software. Click on the ➔</td>
</tr>
<tr>
<td>SureThing Software Help files</td>
<td>Open the software. Click on the Help Menu - Contents</td>
</tr>
<tr>
<td>Email Support</td>
<td><a href="http://www.primera.com/contactsupport">www.primera.com/contactsupport</a></td>
</tr>
<tr>
<td>Phone Support</td>
<td>763-475-6669 (Mon - Fri 8 a.m. - 6 p.m CST)</td>
</tr>
</tbody>
</table>
## Section 4: Technical Specifications

<table>
<thead>
<tr>
<th>Model</th>
<th>Optical Disc Publisher 4100</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configurations</td>
<td>Blu-ray Publisher</td>
</tr>
<tr>
<td></td>
<td>DVD+/ -R-CDR Publisher</td>
</tr>
<tr>
<td>Printing Method</td>
<td>Inkjet</td>
</tr>
<tr>
<td>Printing Resolution</td>
<td>4800 x 1200 dpi, 2400 x 1200 dpi, 1200 x 1200 dpi, 600 x 600 dpi</td>
</tr>
<tr>
<td>Print Head:</td>
<td>Semi-permanent, user-replaceable</td>
</tr>
<tr>
<td>Ink Tanks:</td>
<td>Individual ink cartridges for Cyan, Magenta, Yellow and Black</td>
</tr>
<tr>
<td>Maximum print width</td>
<td>4.724&quot; (120mm)</td>
</tr>
<tr>
<td>Minimum PC System</td>
<td>Intel Pentium IV Processor or higher, 1GB RAM or higher, 10GB or more free hard drive space, available USB 2.0 port.</td>
</tr>
<tr>
<td>Minimum MAC System</td>
<td>Intel CPU running OS X version 10.6 or higher, 512 MB RAM, Free hard drive space of at least 10 GB</td>
</tr>
<tr>
<td>Disc Capacity</td>
<td>50 disc input, 50 disc output (default) 100 disc input, 100 disc output - Kiosk Mode (Kiosk Mode - not included with 4051 models)</td>
</tr>
<tr>
<td>Operating Systems</td>
<td>Window XP, Vista, 7, and 8</td>
</tr>
<tr>
<td></td>
<td>Mac OSX Version 10.6 or higher</td>
</tr>
<tr>
<td>Interface</td>
<td>USB 2.0 port; eSata for Blu-ray models</td>
</tr>
<tr>
<td>Power Requirement</td>
<td>100-240VAC automatic switching 4.5-2.5A, 50/60Hz</td>
</tr>
<tr>
<td>Weight</td>
<td>26 lbs. (11.8kg)</td>
</tr>
<tr>
<td>Dimensions</td>
<td>17.8&quot;W x 11&quot;H x 17.5&quot;D (452.12mmW x 279.4mmH x 447.5mmD)</td>
</tr>
<tr>
<td>Certifications</td>
<td>FCC Class A, CE, ROHS, WEEE</td>
</tr>
<tr>
<td></td>
<td>UL, UL-C, CE</td>
</tr>
<tr>
<td>Warranty</td>
<td>One year return-to-depot</td>
</tr>
</tbody>
</table>

50 Technical Specifications
## Index

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abort</td>
<td>23</td>
</tr>
<tr>
<td>Audio Project</td>
<td>16</td>
</tr>
<tr>
<td>AUDIO_TS</td>
<td>16, 28</td>
</tr>
<tr>
<td>Backup Project</td>
<td>24</td>
</tr>
<tr>
<td>Blu-ray</td>
<td>1, 2, 16</td>
</tr>
<tr>
<td>BDR</td>
<td>1, 2</td>
</tr>
<tr>
<td>Bin Selection</td>
<td>22</td>
</tr>
<tr>
<td>Calibrate Disc Publisher</td>
<td>40</td>
</tr>
<tr>
<td>Center Print Image</td>
<td>40</td>
</tr>
<tr>
<td>Color Matching</td>
<td>37</td>
</tr>
<tr>
<td>Connections, Rear Panel</td>
<td>5</td>
</tr>
<tr>
<td>Controls, Front Panel</td>
<td>4</td>
</tr>
<tr>
<td>Change Robot</td>
<td>20</td>
</tr>
<tr>
<td>Closed Disc</td>
<td>21</td>
</tr>
<tr>
<td>Copy Project</td>
<td>12, 15</td>
</tr>
<tr>
<td>Cost Estimator</td>
<td>39</td>
</tr>
<tr>
<td>Data Project</td>
<td>16</td>
</tr>
<tr>
<td>Disc Cover</td>
<td>12, 32</td>
</tr>
<tr>
<td>File System</td>
<td>21</td>
</tr>
<tr>
<td>Gallery</td>
<td>34</td>
</tr>
<tr>
<td>Identifying the Parts</td>
<td>4</td>
</tr>
<tr>
<td>Image Project</td>
<td>17</td>
</tr>
<tr>
<td>Inner Diameter</td>
<td>14, 19, 38</td>
</tr>
<tr>
<td>Input Bin</td>
<td>5</td>
</tr>
<tr>
<td>Internal Blue LED Lights</td>
<td>44</td>
</tr>
<tr>
<td>iTunes</td>
<td>27</td>
</tr>
<tr>
<td>Kiosk Setup</td>
<td>10</td>
</tr>
<tr>
<td>LED Status Lights</td>
<td>5</td>
</tr>
<tr>
<td>Media Type</td>
<td>2, 50</td>
</tr>
<tr>
<td>New Project Panel</td>
<td>13</td>
</tr>
<tr>
<td>Outer Margin</td>
<td>14, 19, 37</td>
</tr>
<tr>
<td>Output Bin</td>
<td>5</td>
</tr>
<tr>
<td>Power Input</td>
<td>6</td>
</tr>
<tr>
<td>Print Template</td>
<td>25</td>
</tr>
<tr>
<td>Print Quality</td>
<td>7, 15, 36</td>
</tr>
<tr>
<td>Project Set</td>
<td>20</td>
</tr>
<tr>
<td>PTProtect</td>
<td>20, 28</td>
</tr>
<tr>
<td>Publisher Status</td>
<td>23</td>
</tr>
</tbody>
</table>